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The following table shows the revision history for this document.

Date Version Revision
11/07/2012 1.0 Initial Xilinx release.
01/23/2013 2.0 Updated for ISE® Design Suite 14.4 and Vivado® Design Suite 2012.4.
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Launching the Vivado Design Suite Software, page 14, Starting the SuperClock-2
Module, page 16, and Creating the GTX IBERT Core, page 26 for the latest procedures.

VC7203 IBERT Getting Started Guide www.xilinx.com UG847 (v3.0) July 10, 2013


http://www.xilinx.com/warranty.htm
http://www.xilinx.com/warranty.htm#critapps
http://www.xilinx.com

Table of Contents

RevisionHistory ............ ... .. ... .. ... .. ...

Chapter 1: VC7203 IBERT Getting Started Guide

OVerview ....... ... .
Requirements............ .. .. .
Setting Up the VC7203 Board.......................................
Extracting the Project Files .............. .. ... .. ... ... .........
Running the GTX IBERT Demonstration ...........................

Connecting the GTX Transceivers and Reference Clocks .......................
Attach the GTX Quad Connector . . ... ..ottt et e e e
GTX Transceiver Clock Connections ...............ooiiiiiiiii ...
GTX TX/RX Loopback Connections. .. ...,
Configuring the FPGA ... ... ... . . ..
Launching the Vivado Design Suite Software.............................. ...
Starting the SuperClock-2Module .......... ... ... ... ... o ool
Viewing GTX Transceiver Operation ........................................
Closing the IBERT Demonstration ................... ... ... ... ..........

SuperClock-2 Frequency Table ........... ... ... .. ... .. ... .. ... .....

Creating the GTXIBERT Core................. ... ... . .. ...,

Appendix A: Additional Resources

XilINX ReSOUICES . . . oottt i
Solution Centers . ...
Further ReSOUrces . . ... i

Appendix B: Warranty

VC7203 IBERT Getting Started Guide www.xilinx.com
UG847 (v3.0) July 10, 2013


http://www.xilinx.com

& XILINX.

www.xilinx.com VC7203 IBERT Getting Started Guide
UG847 (v3.0) July 10, 2013


http://www.xilinx.com

& XILINX. Overview

Chapter 1

VC7203 IBERT Getting Started Guide

Overview

This document provides a procedure for setting up the VC7203 Virtex®-7 FPGA GTX
Transceiver Characterization Board to run the Integrated Bit Error Ratio Test (IBERT)
demonstration using the Vivado® Design Suite. The designs that are required to run the
IBERT demonstration are stored in a Secure Digital (SD) memory card that is provided
with the VC7203 board. The demonstration shows the capabilities of the Virtex-7
XC7V485T FPGA GTX transceiver.

The VC7203 board is described in detail in VC7203 Virtex-7 FPGA GTX Transceiver
Characterization Board User Guide (UG957).

The IBERT demonstrations operate one GTX Quad at a time. The procedure consists of:
Setting Up the VC7203 Board

Extracting the Project Files

Connecting the GTX Transceivers and Reference Clocks

Configuring the FPGA

Launching the Vivado Design Suite Software

Starting the SuperClock-2 Module

Viewing GTX Transceiver Operation

Closing the IBERT Demonstration

® NS Gk o
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Requirements

The hardware and software required to run the GTX IBERT demonstrations are:

* V(7203 Virtex-7 FPGA GTX Transceiver Characterization Board including:
®  One SD card containing the IBERT demonstration designs
®  One Samtec BullsEye cable
¢ Eight SMA female-to-female (F-F) adapters
e Six 50Q2 SMA terminators
* GTX transceiver power supply module (installed on board)
e SuperClock-2 module, Rev 1.0 (installed on board)

e 12V DC power adapter

¢ USB cable, standard-A plug to Micro-B plug
e Host PC with:

e SD card reader

e USB ports

¢ Xilinx Vivado Design Suite software, version 2013.2 or higher
The hardware and software required to rebuild the IBERT demonstration designs are:

¢ Xilinx Vivado Design Suite version 2013.2 or higher

e PC with a version of the Windows operating system supported by Xilinx Vivado
Design Suite

Setting Up the VC7203 Board

This section describes how to set up the VC7203 board.

Caution! The VC7203 board can be damaged by electrostatic discharge (ESD). Follow standard
ESD prevention measures when handling the board.

When the VC7203 board ships from the factory, it is configured for the GTX IBERT
demonstrations described in this document. If the board has been re-configured it must be
returned to the default set-up before running the IBERT demonstrations.

1. Move all jumpers and switches to their default positions. The default jumper and
switch positions are listed in VC7203 Virtex-7 FPGA GTX Transceiver Characterization
Board User Guide (UG957).

Install the GTX transceiver power module by plugging it into connectors J66 and J97.
Install the SuperClock-2 module:

a. Align the three metal standoffs on the bottom side of the module with the three
mounting holes in the SUPERCLOCK-2 MODULE interface of the VC7203 board.

b. Using three 4-40 x 0.25 inch screws, firmly screw down the module from the
bottom of the VC7203 board.

c.  On the SuperClock-2 module, place a jumper across pins 2-3 (2V5) of the
CONTROL VOLTAGE header, J18, and place another jumper across 51570 INH
header J11.

d. Screw down a 50Q2 SMA terminator onto each of the six unused Si5368 clock
output SMA connectors: J7, J8, J12, J15, J16 and J17.
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Extracting the Project Files

The Vivado project files required to run the IBERT demonstrations are located in
vc7203_ibert. zip on the SD card provided with the VC7203 board. They are also
available online (as collection rd£0272_2013_2.zip) at:

www.xilinx.com/vc7203

The ZIP collection also contains two Tcl scripts: add_scm2.tcl and
setup_scm2_156_25. tcl, and seven Vivado probe files: ve7203_g113.1tx,
vc7203_gll4.1tx,vec7203_gll15.1tx,ve7203_gll6.1tx,vc7203_gll7.1tx,
vc7203_gl18.1tx, and ve7203_qgl19.1tx. The Tcl scripts are used to help merge the
IBERT and SuperClock-2 source code (described in Creating the GTX IBERT Core, page 26)
and to set up the SuperClock-2 module to run at 156.25 MHz (described in Launching the
Vivado Design Suite Software, page 14). The debug probes are used by Vivado design tools
to properly load the SuperClock-2 VIO core.

To copy the files from the Secure Digital memory card:

1. Connect the Secure Digital memory card to the host computer.
2. Locate the file ve7203_ibert . zip on the Secure Digital memory card.

3. Unzip the files to a working directory on the host computer.

Running the GTX IBERT Demonstration

The GTX IBERT demonstration operates one GTX Quad at a time. This section describes
how to test GTX Quad 115. The remaining GTX Quads are tested following a similar series
of steps.

Connecting the GTX Transceivers and Reference Clocks

Figure 1-1 shows the locations for GTX transceiver Quads 115, 116, 117, and 118 on the
VC7203 board.

Note: Figure 1-1 is for reference only and might not reflect the current revision of the board.
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Figure 1-1: GTX Quad Locations

All GTX transceiver pins and reference clock pins are routed from the FPGA to a connector
pad which interfaces with Samtec BullsEye connectors. Figure 1-2 A shows the connector
pad. Figure 1-2 B shows the connector pinout.
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GTX Connector Pad GTX Connector Pinout

UG847_c1_02_110112

Figure 1-2: A — GTX Connector Pad. B — GTX Connector Pinout

The SuperClock-2 module provides LVDS clock outputs for the GTX transceiver reference
clocks in the IBERT demonstrations. Figure 1-3 shows the locations of the differential clock
SMA connectors on the clock module which can be connected to the reference clock cables.

Note: The image in Figure 1-3 is for reference only and might not reflect the current revision of the
board.
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UG847_c1_03_103112
Figure 1-3: SuperClock-2 Module Output Clock SMA Locations

The four SMA pairs labeled CLKOUT provide LVDS clock outputs from the Si5368 clock
multiplier /jitter attenuator device on the clock module. The SMA pair labeled 5i570_CLK
provides LVDS clock output from the Si570 programmable oscillator on the clock module.

Note: The Si570 oscillator does not support LVDS output on the Rev B and earlier revisions of the
SuperClock-2 module.

For the GTX IBERT demonstration, the output clock frequencies are preset to 156.25 MHz.
For more information regarding the SuperClock-2 module, see HW-CLK-101-SCLK2
SuperClock-2 Module User Guide (UG770).

Attach the GTX Quad Connector

Before connecting the BullsEye cable assembly to the board, firmly secure the blue
elastomer seal provided with the cable assembly to the bottom of the connector housing if
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it is not already inserted (see Figure 1-4).

Note: Figure 1-4 is for reference only and might not reflect the current version of the connector.

UG847_c1_04_1013112
Figure 1-4: BullsEye Connector with Elastomer Seal

Attach the Samtec BullsEye connector to GTX Quad 115 (Figure 1-5), aligning the two
indexing pins on the bottom of the connector with the guide holes on the board. Hold the
connector flush with the board and fasten it by tightening the two captive screws.

UG847_c1_05_10312

Figure 1-5: BullsEye Connector Attached to Quad 115

GTX Transceiver Clock Connections

See Figure 1-2, page 9 to identify the P and N coax cables that are connected to the CLK1
reference clock inputs. Connect these cables to the SuperClock-2 module as follows:

e CLK1_P coax cable - SMA connector J5 (CLKOUT1_P) on the SuperClock-2 module
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CLK1_N coax cable - SMA connector J6 (CLKOUT1_N) on the SuperClock-2
module

Note: Any one of the five differential outputs from the SuperClock-2 module can be used to source
the GTX reference clock. CLKOUT1_P and CLKOUT1_N are used here as an example.

GTX TX/RX Loopback Connections

See Figure 1-2, page 9 to identify the P and N coax cables that are connected to the four
receivers (RX0, RX1, RX2 and RX3) and the four transmitters (TX0, TX1, TX2 and TX3). Use
eight SMA female-to-female (F-F) adapters (Figure 1-6), to connect the transmit and
receive cables as shown in Figure 1-7 and detailed here:

TX0_P — SMA F-F Adapter - RX0_P
TX0_N — SMA F-F Adapter - RX0_N
TX1_P — SMA F-F Adapter - RX1_P
TX1_N — SMA F-F Adapter - RX1_N
TX2_P — SMA F-F Adapter —» RX2_P
TX2_N — SMA F-F Adapter - RX2_N
TX3_P - SMA F-F Adapter - RX3_P
TX3_N — SMA F-F Adapter - RX3_N

Note: To ensure good connectivity, it is recommended that the adapters be secured with a wrench;
however, do not over tighten the SMAs.

0 it

UG847_c1_06_103112

Figure 1-6: SMA F-F Adapter

TX Coax

SMA F-F Adapter
//—RX Coax ;
\
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Figure 1-7: TX-To-RX Loopback Connection Example

Figure 1-8 shows the VC7203 board with the cable connections required for the Quad 115
GTX IBERT demonstration.

VC7203 IBERT Getting Started Guide www.xilinx.com 11

UGS847 (v3.0) July 10, 2013


http://www.xilinx.com

Chapter 1:

VC7203 IBERT Getting Started Guide & XILINX.

TX/RX Loopback

Connections

QUAD 115 CLKOUT_1N
B CLKOUT_1P

UG847_c1_08_110612

Figure 1-8: Cable Connections for Quad 115 GTX IBERT Demonstration

Configuring the FPGA

This section describes how to configure the FPGA using the SD card included with the
board. The FPGA can also be configured through the Vivado Design Suite software using
the .bit files and .1tx probe files which are available online (as collection
rdf0272_2013_2.zip) at:

www.xilinx.com/vc7203

To configure from the SD card:

1.

Insert the SD card provided with the VC7203 board into the SD card reader slot located
on the bottom-side (upper-right corner) of the VC7203 board.

Plug the 12V output from the power adapter into connector ]2 on the VC7203 board.

Connect the host computer to the VC7203 board using a standard-A plug to Micro-B
plug USB cable. The standard-A plug connects to a USB port on the host computer and
the Micro-B plug connects to U8, the Digilent USB JTAG configuration port on the
VC7203 board.

Select the GTX IBERT demonstration with the System ACE™ SD controller SYSACE-2
CFG switch, SW8. The setting on this 4-bit DIP switch (Figure 1-9) selects the file used
to configure the FPGA. A switch is in the ON position if set to the far right and in the
OFF position if set to the far left. For the Quad 115 GTX IBERT demonstration, set

12
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ADR2 = ON, ADR1 = OFF, and ADRO = ON. The MODE bit (switch position 4) is not
used and can be set either ON or OFFE.

5. Place the main power switch SW1 to the ON position.

Figure 1-9: Configuration Address DIP Switch (SW8)

SYSACE-2 CFG

SWs8
ADRO
ADR1
ADR2

MODE

UG847_c1_09_110112

There is one IBERT demonstration design for each GTX Quad on the VC7203 board, for a

total of seven IBERT designs. An additional design is provided to demonstrate the

USB/UART interface (details of this demonstration are described in the README file on the
SD card). All eight designs are organized and stored on the SD card as shown in Table 1-1.

Table 1-1: SD Card Contents and Configuration Addresses

Demonstration

Design ADR2 ADR1 ADRO
GTX Quad 113 ON ON ON
GTX Quad 114 ON ON OFF
GTX Quad 115 ON OFF ON
GTX Quad 116 ON OFF OFF
GTX Quad 117 OFF ON ON
GTX Quad 118 OFF ON OFF
GTX Quad 119 OFF OFF ON

USB/UART OFF OFF OFF
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Launching the Vivado Design Suite Software

1. Start Vivado Design Suite on the host computer and click File > Open Hardware

Session (highlighted in Figure 1-10).

b 4 Vivado 2013.2 <@mekong>
File | Tools  MWindow Help Search commands |
4 Mew Project...
[* Qpen Project..
Open Recent Project 3
Open Example Project  » X”_lNX
Open Checkpaint. .. =
Open Recent Checkpaint »
|I:I (Open Hardware Session |
Exit d Documentation
/-- —\ Create New Project e Documentation and Tutorials
| # | ) ) o
\i= l". N me le_ard il GRIEIR /80 G th_e (A= Invaluable for first time users ar to try new features.
\ \\ of selecting design sources and a target device for
— a new project.
/ Open Project User Guide
\ Open ohe of the most recently used projects or More detailed info on Yivado cormmands, dialogs,
any previously created project. and buttons.
Open Example Project Quick Take Videos
ORpEn one of the twtorial projects. View a series of short videos on various topics fram
design flows ovendew to recommended methodology.
Manage IP Release Notes Guide
(70 13 17 () S| WAL GV (i . Infarmation about installation and new IDS features
Create and customize IP to be used in a new project N
- ) in this release.
or open previously customized IP to make changes.
[ Tel Console
UG847_c1_10_052413
Figure 1-10: Vivado Design Suite, Open Hardware Session
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2. In the Hardware Session window, click Open a new hardware target (highlighted in
Figure 1-11).

b d Vivado 2013.2 =@mekong

File Edit Tools MWindow Layout Yiew Help [O- search commands |
ﬁ@|ﬂ“.-X|%%|@|§Defauluawut '|!‘\|©
Hardware Session - unconnected x
@ Mo hardware target is open. Dpen recent target |Omen a hew hardware target |
| Hardware —O¢ % |
o x=HM»E
MName |Status
1 I [ 10T}
| Properties —Or % |
« »[Ek
| Debug Probes —Owr x

Mame Compare Ywalue Trigger Cond Trigger Pos Data Depth

B3 v[HE{ENP

ILA Cores VIO Cores q
B Tcl Console | © Messages = Debug Probes

B

e

UG847_c1_11_052413

Figure 1-11: Open a New Hardware Target

3. An Open Hardware Target wizard pops up. Click Next on the first window.

In the Vivado CSE Server Name window, make sure localhost:60001 is entered for
the Server name. Click Next and it opens the server to connect to the Digilent JTAG
cable.

5. In the Select Hardware Target window, the Digilent cable appears under Hardware
Targets and the JTAG chain contents of the selected cable under Hardware
Devices (Figure 1-12). Select digilent_plugin and click Next.
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Vivado 2013.2 <@mekong > ]
F|Ie Edit Tools Window Layout Yiew Help

19 Default Layout - |! ‘ \ | L\)

(O Search commands

Hardware Session - unconnected

@ Mo hardware targe'

« +[%x

Open Hc-w Hardware Target <bm|kong> - ]
Harchware Select Hardware Target
.\ g =|E N » | Select a hardware target fram the list of available targets on the Yivado C5E Server (vise_server). E]
Mame
Harchware Targets
[ Type [Port [ESN
@ digilent_plugin SM:2102518058763
Properties

Hardware Dewvices

[ Name |Dcode  [IRLenmh |
& System_ACE_CF_0 0A00109% 8
@ACTVX485T_1 33687092 6

I A A RIS

r——

|Debug Probes —Oe=x |
Name Comp
Server: ¥sjdiahann2 0. xlny xiling. com: 60001, Yersion: 20
| | <gack || mews || Enish | [ cancal |
|
ILA Cores W0 Cores L |
B Tcl Console © Messages . s Debug Probes

Starting the SuperClock-2 Module

UGB47_c1_12_052413

Figure 1-12: Select Hardware Target

6. Inthe Set Hardware Target Properties window, leave the defaults and click Next. In the
Open Hardware Target Summary window, click Finish. The wizard closes and the
Vivado tool opens the hardware target.

The IBERT demonstration designs use an integrated VIO core to control the clocks on the
SuperClock-2 module. The SuperClock-2 module features two clock-source components:

1) An always-on Si570 crystal oscillator and, 2) an Si5368 jitter-attenuating clock multiplier.
Outputs from either device can be used to drive the transceiver reference clocks.

16

www.xilinx.com VC7203 IBERT Getting Started Guide

UG847 (v3.0) July 10, 2013


http://www.xilinx.com

& XILINX. Running the GTX IBERT Demonstration

To start the SuperClock-2 module:

1. The Hardware window shows the System ACE and the XC7VX485T device and
reports that it is programmed. Select XC7VX485T_1. In the Hardware Device
Properties window, enter the file path to the Probes file associated with the Q115
IBERT design (vc7203_qgl115.1tx) (Figure 1-14).

L dVivado 2013.2 <@xsjl23171>

File Edit Tools Window Layout Yiew Help [Q- search commands ]
AR Do RE X | X @ |% Default Layout - |H &K | ©
| Hardware Session - xsjdiahann2 0. xInx. xilinx. comfdigilent_plugin/sM: 2 1025 1803763 x_|
@ There are no debug cores. Program dewvice Eefresh dewice

Hardhware — O X
QI E| |

Mame |Stalus |

@ uxsjdiahann20.xlnxxilind.com (1) Connected
$—E0 digilent_pluginfsh:210251... Open
|- s Tem_ACE_CF_0 () Mot programmed
| L XCTVX485T_1 (0) (active) Prograrmmed

Hardware Device Properties — O 2 x

= [Pk ]|

@ KCTYX4E5T_1

[~]
Programming file: | ||j
|Probes file: |jiber‘t,?series,gtx,Ojexample,projectjiber‘tJseries,gtx,0,examplefiben,?series,gtx,o,example.runs,fimpl,1jdebug,nets.ltx ||j| E
User chain count: 4 =
General Properties
Debug Probes — 0O 2 X
O\ MHame “Walue ACtivity
E
pl
»
"]
ILA Cores W10 Cores 4 B
= Tcl Console | © Messages . e Debug Probes
UGB47_c1_13_05241 3
Figure 1-13: Adding the Probes File
2. In the Hardware window, right-click XC7VX485T_1 and select Refresh Device
(Figure 1-14).
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b dVivado 2013.2 <=@xsjl23171>
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€
=
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b
=
ILA Cores %10 Cores 4 B
E Tcl Console | © Messages . = Debug Probes
L]
UG847_c1_14_052413
Figure 1-14: Refresh Device
3. The Vivado tool now shows the SuperClock-2 VIO core and the IBERT core. To

configure the SuperClock-2 module, select Tools > Run Tcl Script (Figure 1-15). In the
following Run Script window, navigate to the setup_scm2_156_25. tcl scriptin
the extracted files and click OK.

18

www.xilinx.com VC7203 IBERT Getting Started Guide

UG847 (v3.0) July 10, 2013


http://www.xilinx.com

& XILINX.

Running the GTX IBERT Demonstration
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|Hardware Device Froperties — 0O X |
€
@ XCTVX485T_ 1
Marne: HCTWXAB5T 1 -
Part: KCTVHA4E5T
1D code: 33687093
IR length: [
s programmakle
i e | —
K S| o=
General Properties

| Debug Probes

Narme | Compare Value

| Trigger Cond

[Trigger Pos [DataDepth |

ILA Cores IO Cores

& Tcl Console | © Messages . = Debug Probes e
L]
UGB47_c1_15_052413
Figure 1-15: Run Tcl Script...
4.

To view the SuperClock-2 Module VIO core, select the VIO Cores view in the Debug
Probes tab of the Debug Probes window (Figure 1-16).

Note: The ROM address values for the Si5368 and Si570 devices (that is, si5368_addr{6:0]
and si570_addr[6:0]) are preset to 60 to produce an output frequency of 156.250 MHz. Entering
a different ROM address changes the reference clock(s) frequency. The complete list of

pre-programmed SuperClock-2 frequencies and their associated ROM addresses is provided in
Table 1-2, page 23.
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Debug Probes [ I Ea
A | Mame [value | Activity
= o2 hw‘.\mfl
= o= win_inputs
A e U_scm2 fu_vio_sclkZ _controlfi2c_ack H1
e U_scm fu_wio_sclkZ _control/i2c_done [H] O
O=ig u_scm fu_vio_sclk2 _controlfi2c_rd_data[7:0] [H] 00
@t U_scm2 fu_wio_sclkz _controlfpcad_ctr[5:0] [H] 0
Geig U_som2 fu_wio_sclkz _contralfpoal_ctrl[%:0] [H] Go
] Geig U_sem2 fuio_sclkz _cantralfsclk_in[8: 0] [H] G,
G=ig U_som2 fuwio_sclkZ _contralfsclk_out[5:0] [H] o0&
e U_sCm2 fu_sio_sclk2 _controlfsis 368 _done [HQ
G=ig U_sem2 fuwio_sclkZ _contralfsin3eE_freq[19:0] [U] 156250
e U_scm2 fu_io_sclk2 _control/siS70_done [HI O
@tz u_scm2fu o sclk2 _control/siS70_freq[19:0] [U] 156250
P~ win_outputs
@tz u_scm fu_vio_sclk2 _controlfi2c_dev_addr[7:0] [H] 00
e U_scm fu_vio_sclkZ _cantralfiZc_noreg [H] O
@i U_scm2 fu_wvio_sclke _controlfi2c_reg_addr[7:0] [H] 00
e u_scm fu_vio_sclkZ _controlfi2c_start [H] O
Geig U_som2 fuio_sclkZ _contralfi2 cowr_data[7: 0] [H] 00
Geig U_sem2 fuwio_sclkZ _contralfpcad_ctrl 1[5:0]  [H] 00
g u_scm2 fu_sio_sclk2 controlfpcal_ctrl_1{5:0]  [H] 00
e U_scmz2 fuwio_sclkZ _contralfsclk? reset [HQ
Smg L_SCmZ fu_vio_sclkZ _controlfsclk_out_1[5:0] H] 08 The ROM address value for the
| @iz u_scm2 fu_vio_sclk2 _control/si5368_addr{6:0] [U] &0 | - Si5368 and Si570 clock multiplier is
=iz L_scm2 fu_io_sclk2 _controlfsiS 368 _clkin[1:0] [H] 1 preset to 60 (156.25 MHz)
Hle u_scm2 fu_vio_sclkZ _control/siS 368 _cllkwr [H] O
=z L_scm fu_vio_sclkZ _control/siz 368 _dsbl[4:0] [H] 00
Hls u_scmd fu_wio_sclk2 _control,/siz 268 _reset [H] O . .
Fie U_stm2 u_vio_sclk2 _controljsiz268_start HI o -t Si5368 and Si570 Start button
BTs USLmZ, W Win_sCIke CONtrolais 70_adan6.0] (U] 50 < (Clock starts on a rising edge)
G=ig U_scm2 fu_vio_sclk2 _control/si570 idcode[6:0] [H] 55
—le U_sem2 fu_wio_sclkz _cantral/sis 70 _recall [HIQ
| Ele u_sem2 fu_win_sclke _controlfsis 70_start [H0 | -
ILACUresl VIO Cores | 4 b B
BTl Console © Messa;*as = Debuqg Probes

UGBA47_c1_16_052413

Figure 1-16: SuperClock-2 Module VIO Core

5. To view the GTX transceiver operation, click Layout > Serial I/O Analyzer. In the
Links window, right-click and select Create Links... or press the Create Links button

(Figure 1-19).

20

www.Xxilinx.com

VC7203 IBERT Getting Started Guide
UG847 (v3.0) July 10, 2013


http://www.xilinx.com

& XILINX. Running the GTX IBERT Demonstration

b 4 Vivado 2013.2 =@xsjl23171

File Edit Toaols Window Layout Yiew Help [OF searck commands |
f 1

AR 2o Bl XX @|Eseralo sazer - I & K| ®

Hardware Session - xsjdiahann2 0. xlnx. xilink. com/fdigilent_plugin fSH:2 1025 1804763 X

@ There are no serial IO links. Create links

|Hardware — O @ = |
az=EM»E
MName |Status

@ B xsjdighann20.xinx.xiling.cam (1) Connected -
$—E0 digilent_plugin/SN:210251... Qpen

& System _ACE_CF_0 () Mot prograrm
& XCTVX485T_1 (2} (active)  Programmed
Sk IBERT
@[ Quad_115 (5) -
4 2 [m]
| Hardware Device Properties — O @ = |

+ + %%

@ XC7VX485T_1

MName: HKCTVXABST L B
Fart: HKOTWHABET F
1D code: 23I6ET093
IF. length: [
Is pragrammatle =]
DE
General FProperties
| Links —Owe x|
&, | Mame |T)( R Status Bits |Err0rs BER. BEET Reset TX Pattern FX Pattern |T)( Pre
== | —[ Ungrouped Links (0}
=
& B Froperties. .. Ctri+E
E X Delete Delete
E I_"'S Create Links...
& @ Create Link Group...
B B Create Scan. .
= Commit Properties
e I @ Refresh Serial 1/0 Ohjects
Tcl Console  © Messages % Links Scans Export to Spreadsheet...

]

UGB47_c1_17_052413

Figure 1-17: Serial I/O Analyzer - Create Links...

6. A Create Links window pops up. In this window you can link any TX to RX GTs. To
create links, select the TX GT and RX GT from the two lists, then press the Add (+)
button. For this project, connect the following links:

MGT_X1Y8/TX to MGT_X1Y8/RX
MGT_X1Y9/TX to MGT_X1Y9/RX
MGT_X1Y10/TX to MGT_X1Y10/RX
MGT_X1Y11/TX to MGT_X1Y11/RX

This is shown in Figure 1-18.
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6' To create a new link select a TX andjor an EX, then press the Add (+) button.
-4

TH OTs R CTs
Search: | | search: |
Mew Links
Description TX |R)(
S Link 0 MOT X IYE/ T MOT _X1IVE/RX
S Link 1 MOT X LIYS T MOT XK 1V9/RX
S Link 2 MOT X IYLOTH MOT K 1v10/RX
S Link 3 MOT X IYLL,TH MOT _K1v11/RX
%]
¥|Create link group|
Link group description: |Link Group O |
O ] | Zancel ]

UG847_c1_18_052413

Figure 1-18: Create Links Window

Viewing GTX Transceiver Operation

After completing step 6 in Starting the SuperClock-2 Module, the IBERT demonstration is
configured and running. The status and test settings are displayed on the Links tab in the
Links window shown in Figure 1-19.

Note the line rate, TX differential output swing, and error count:

® The line rate for all four GTX transceivers is 12.5 Gb/s (see Status in Figure 1-19).
® The GTX transmitter differential output swing is preset to 250 mV.

®  Verify that there are no bit errors.
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RdVivado 2013.2 <@xs)123171> "

File Edit Tools Window Layout Yiew Help

2|0 o B X | X|@Eseapaizr | & %] ©
Hardware Session - xsjdiahann20.xlnx ilinx.com/digilent_plugin/Shi:2 1025 1806763 X

| Hardware — O x|
az=Er»E
Mame [stats

@ B xsidizhann2 0 xinxxilink.com (1) Connected
& @o digilent_plugin/sN:210251... Open

& System_ACE_CF_0 (0) Mot program
& XCTVXA8ST_1 (2 (active)  Programmed
& BERT
& Quad_115 (5)
-
K] LU
| Hardware Device Properties = T
« > [FE R

B XCPYXAB5T_1

Name: HCTVX4E5T_1
Part XCTVX485T
ID code: 32687093

IR length 3

Is programmable

General FProperties

 Links o x
@, [Name [Tx [Rxc Status Bits Errors_|BER BERT Reset [TX Pattern | RX Pattern [ TX Pre-Cursor | TX Post-Cursor | TX Diff Swina | DFEE..[Inject E..| T Reset [Rx Reset [RX PLLSt.. [TX PLLS!
i | i Ungrouped Links (0]

2 |#% unk Group 0 (4) Reset  PRES 7-bit PRES 7-bit 167 dB (00111) 0,68 dB (00011)  [850 mY (1100) 2 nject  Reset  Reset

= % Link 0 MCT_X1Y8/TX  MGT_X1v8/RX |12.500 Ghps [ 1.116E13 §958E-14  Reset  PRES 7-bit PRES 7-bit 167 dB (00111) 0.68 dB (00011)  [850 mV (1100) 4 nject  Reset  Reset Llocked  Locked

% Link 1 MGT X1¥9 T MGT X1v9/RX [12.500 Ghps | 1.117E13 8956E-14  Reset  PRBS 7-hit PRBS 7-bit 167 0B (00111) (.68 dB(00011) [850 mV (1100) @ et Reset  Reset Llocked  Locked
= % Link 2 MCT_X1Y10/TX MCT_X1Y10/R¥|12.500 Ghps [ 1.117E12 8.954E-14  Reset  PRBS 7-bit PRBS 7-bit 167 dB (00111) 0.68 dB (00011)  [850 mV {1100) 4 nject  Reset  Reset Llocked  Locked

L] % Link 3 MGT X1¥11/TX MGT X1¥11/RX|12.500 Ghps | 1.117E12 8952E-14  Reset PRBS 7-bil PRES 7-bit 167 dB (00111) 0.68 dB(00011) [850 mV (1100) @ et Reset  Reset Llocked  Locked

L]

(%]

B Tcl Console | © Messages % Links & Scans

|

UG847_c1_19_060513

Figure 1-19: Serial I/O Analyzer Links

Additional information on the Vivado Design Suite software and IBERT core can be found
in Vivado Design Suite User Guide: Programming and Debugging (UG908) and LogiCORE IP
Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers Product Guide for Vivado
Design Suite (PG132).

Closing the IBERT Demonstration

To stop the IBERT demonstration:
1. Close the Vivado Design Suite application by selecting File > EXxit.

2. Place the main power switch SW1 in the off position.

SuperClock-2 Frequency Table

Table 1-2 lists the addresses for the frequencies that are programmed into the SuperClock-2
read-only-memory (ROM).

Table 1-2: Si570 and Si5368 Frequency Table

Frequency Frequency Frequency
Address Protocol (MHz) Address Protocol (MHz) Address Protocol (MHz)
0 100GE/40GE/10 1 161130 30 OBSAI 307.200 60 XAUI 156.250
1 Aurora 81.250 31 OBSAI 614.400 61 XAUI 312.500
2 Aurora 162.500 32 0C-48 19.440 62 XAUI 625.000
3 Aurora 325.000 33 OC-48 77.760 63 Generic 66.667
4 Aurora 650.000 34 0OC-48 155.520 64 Generic 133.333
5 CE111 173.370 35 0OC-48 311.040 65 Generic 166.667
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Table 1-2: Si570 and Si5368 Frequency Table (Contd)

Address Protocol Frtznqnlll_'ezr)lcy Address Protocol Fr((alt\]nlil_'ezr)\cy Address Protocol Frtz'?nlll_'ezr)lcy
6 CPRI 61.440 36 0OC-48 622.080 66 Generic 266.667
7 CPRI 122.880 37 OTU-1 166.629 67 Generic 333.333
8 CPRI 153.630 38 OTU-1 333.257 68 Generic 533.333
9 CPRI 245.760 39 OTU-1 666.514 69 Generic 644.000
10 CPRI 491.520 40 OTU-1 666.750 70 Generic 666.667
11 Display Port 67.500 41 OTU-2 167.330 71 Generic 205.000
12 Display Port 81.000 42 OTU-2 669.310 72 Generic 210.000
13 Display Port 135.000 43 OTU-3 168.050 73 Generic 215.000
14 Display Port 162.000 44 OTU-4 174.690 74 Generic 220.000
15 Fibrechannel 106.250 45 PCle 100.000 75 Generic 225.000
16 Fibrechannel 212.500 46 PCle 125.000 76 Generic 230.000
17 Fibrechannel 425.000 47 PCle 250.000 77 Generic 235.000
18 GigE 62.500 48 SATA 75.000 78 Generic 240.000
19 GigE 125.000 49 SATA 150.000 79 Generic 245.000

20 GigE 250.000 50 SATA 300.000 80 Generic 250.000
21 GigE 500.000 51 SATA 600.000 81 Generic 255.000
22 GPON 187.500 52 SDI 74.250 82 Generic 260.000
23 Interlaken 132.813 53 SDI 148.500 83 Generic 265.000
24 Interlaken 195.313 54 SDI 297.000 84 Generic 270.000
25 Interlaken 265.625 55 SDI 594.000 85 Generic 275.000
26 Interlaken 390.625 56 SMPTE435M 167.063 86 Generic 280.000
27 Interlaken 531.250 57 SMPTE435M 334.125 87 Generic 285.000
28 OBSAI 76.800 58 SMPTE435M 668.250 88 Generic 290.000
29 OBSAI 153.600 59 XAUI 78.125 89 Generic 295.000
90 Generic 300.000 103 Generic 365.000 116 Generic 430.000
91 Generic 305.000 104 Generic 370.000 117 Generic 435.000
92 Generic 310.000 105 Generic 375.000 118 Generic 440.000
93 Generic 315.000 106 Generic 380.000 119 Generic 445.000
94 Generic 320.000 107 Generic 385.000 120 Generic 450.000
95 Generic 325.000 108 Generic 390.000 121 Generic 455.000
96 Generic 330.000 109 Generic 395.000 122 Generic 460.000
97 Generic 335.000 110 Generic 400.000 123 Generic 465.000
98 Generic 340.000 111 Generic 405.000 124 Generic 470.000
99 Generic 345.000 112 Generic 410.000 125 Generic 475.000
100 Generic 350.000 113 Generic 415.000 126 Generic 480.000
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SuperClock-2 Frequency Table

Table 1-2: Si570 and Si5368 Frequency Table (Contd)

Address Protocol Frtznqnlll_'ezr)lcy Address Protocol Frt(alt\]nlil_'ezr)\cy Address Protocol Frtz'?nlll_'ezr)lcy
6 CPRI 61.440 36 0OC-48 622.080 66 Generic 266.667
7 CPRI 122.880 37 OTU-1 166.629 67 Generic 333.333
8 CPRI 153.630 38 OTU-1 333.257 68 Generic 533.333
9 CPRI 245.760 39 OTU-1 666.514 69 Generic 644.000
10 CPRI 491.520 40 OTU-1 666.750 70 Generic 666.667
11 Display Port 67.500 41 OTU-2 167.330 71 Generic 205.000
12 Display Port 81.000 42 OTU-2 669.310 72 Generic 210.000
13 Display Port 135.000 43 OTU-3 168.050 73 Generic 215.000
14 Display Port 162.000 44 OTU-4 174.690 74 Generic 220.000
15 Fibrechannel 106.250 45 PCle 100.000 75 Generic 225.000
16 Fibrechannel 212.500 46 PCle 125.000 76 Generic 230.000
17 Fibrechannel 425.000 47 PCle 250.000 77 Generic 235.000
18 GigE 62.500 48 SATA 75.000 78 Generic 240.000
19 GigE 125.000 49 SATA 150.000 79 Generic 245.000

20 GigE 250.000 50 SATA 300.000 80 Generic 250.000
21 GigE 500.000 51 SATA 600.000 81 Generic 255.000
22 GPON 187.500 52 SDI 74.250 82 Generic 260.000
23 Interlaken 132.813 53 SDI 148.500 83 Generic 265.000
24 Interlaken 195.313 54 SDI 297.000 84 Generic 270.000
25 Interlaken 265.625 55 SDI 594.000 85 Generic 275.000
26 Interlaken 390.625 56 SMPTE435M 167.063 86 Generic 280.000
27 Interlaken 531.250 57 SMPTE435M 334.125 87 Generic 285.000
28 OBSAI 76.800 58 SMPTE435M 668.250 88 Generic 290.000
29 OBSAI 153.600 59 XAUI 78.125 89 Generic 295.000
90 Generic 300.000 103 Generic 365.000 116 Generic 430.000
91 Generic 305.000 104 Generic 370.000 117 Generic 435.000
92 Generic 310.000 105 Generic 375.000 118 Generic 440.000
93 Generic 315.000 106 Generic 380.000 119 Generic 445.000
94 Generic 320.000 107 Generic 385.000 120 Generic 450.000
95 Generic 325.000 108 Generic 390.000 121 Generic 455.000
96 Generic 330.000 109 Generic 395.000 122 Generic 460.000
97 Generic 335.000 110 Generic 400.000 123 Generic 465.000
98 Generic 340.000 111 Generic 405.000 124 Generic 470.000
99 Generic 345.000 112 Generic 410.000 125 Generic 475.000
100 Generic 350.000 113 Generic 415.000 126 Generic 480.000
VC7203 IBERT Getting Started Guide www.xilinx.com 25

UGS847 (v3.0) July 10, 2013


http://www.xilinx.com

Chapter 1: VC7203 IBERT Getting Started Guide

& XILINX.

Table 1-2: Si570 and Si5368 Frequency Table (Contd)

Frequency Frequency Frequency
Address Protocol (MHz) Address Protocol (MHz) Address Protocol (MHz)
101 Generic 355.000 114 Generic 420.000 127 Generic 485.000
102 Generic 360.000 115 Generic 425.000

Creating the GTX IBERT Core

Vivado Design Suite version 2013.2 or higher is required to rebuild the designs shown

here.

This section provides a procedure to create a single Quad GTX IBERT core with integrated
SuperClock-2 controller. The procedure assumes Quad 113 and 12.5 Gb/s line rate, but

cores for any of the GTX Quads with any supported line rate can be created following the
same series of steps.

For more details on generating IBERT cores, refer to Vivado Design Suite User Guide:
Programming and Debugging (UG908).

1. Start the Vivado Design Suite.
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Creating the GTX IBERT Core

2. In the Vivado design tools window, click the Manage IP icon, then select Open IP
Catalog (highlighted in Figure 1-20).

v

-0X

File Tools

Window Help

[ Search commands

—

47\

VIVADO™>

Getting Started

Create New Project

Mew Project Wizard will guide you through the process
of selecting design sources and a target dewice far
a new project

Open Project

Cpen one of the most recently used projects or
any previously created project.

Open Fxample Project

Qpen one of the tutorial projects.

Manage IP

Cpen the IP Catalog and wiew availahle IP.

Create and customize IP to be used in a new project
or open prewvioushy custamized P to make changes.

XILI

Documentation

Documentation and Tutorials

Inwvaluahle for first time users or to try new features

User Guide

More detailed info on Yivado commands, dialogs,
and buttons.

Quick Take Yideos

“iew a series of short videos on warious topics from
design flows owverview to recommended methodology.

Release Notes Guide

Infarmation about installation and new IDS features
in this release

NX

MMASLE.

5 Tl Console

Figure 1-20:

UG847_c1_20_052413

Initial window, Vivado Design Suite

3. When the Create a New Customized IP Location dialog window opens (not shown),

click Next.
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4. Inthe Manage IP Settings window, select a part by clicking the (...) button next to the
Part field. A Select Device window pops up. Use the drop-down menu items to narrow
the choices. Select the xc7vx485tffg1761-3 device (Figure 1-21). Click OK.

Specify Eilter
Product u:ategor\,.f|AJI - | Package |ffgl?61 a |
& Boards Eamilv|‘-firtex—? - | Speed grade |—3 - |
Sgb—FamiIv|AJl Femaining hd | Temp grade |,£'»JI Femaining - |
| Feset All Filters
Search: | |
[0 Pin Available LuT ' Block, Gh GTXEZ
i Count I0Bs Elerments il FLAM & s Transceivers | Transceivers
@ e TVSB5fgl761-3 1,7¢1 850 364200 728400 7L 1260 36 36
@ 730G 1761-3 1,7¢1 700 204000 408000 750 1120 28 9] 2
KO w4851l 761-3 1,7e1 700 303600 607200 1030 2800 28 28 (I
G RC e 90tffigl e 1-3 1,7¢1 850 433200 866400 1470 3600 E 4] E
1| {(l I PID
|| OF ” | Cancel ]
UG847_c1_21_052413
Figure 1-21: Select Device
5. Back on the Manage IP Settings window, select Verilog for Target language, Vivado
Simulator for Target simulator, and a directory to save the customized IP (Figure 1-22).
Click Finish.
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FV Open IP Catalog =@xsjl23 610
Manage IP Settings -
et options for IP to displayed in the catalog and IP Custamization output pracucts, ﬁli

Far: [ #e7 w4851 176 1-3 (active) | -]

Target language: |Veri|ng - |

Target simulator: |Vi\.fad0 sirnulator T |

IP location: |C:;Dncuments and Settings/ ||j
< Back l| Mlext = ||| Finizh l| | Cancel

UGB4T7_c1_22_052413

Figure 1-22: Manage IP Settings

6. Inthe Vivado IP Catalog window, open the Debug & Verification folder, then open the

Debug folder, and double-click IBERT 7 Series GTX (Figure 1-23).
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b Manage IP - [/ho

me/rhansen/VHDL designs/MGT-VC7203_IBERT/VC7203_IBERT G5G/Q113] - Vivado 2013.2 =@xsjI23 610>

File Edit Tools Window Layout  Yiew Help |\IL Search commands
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@[> Debug
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o= = Digital Signal Processing [~]
o=~ Embedded Pracessing =]
Details
Marne: IBERT 7 Series GTX =
Wersion: 2.0
Description:  The IBERT 7 Series GTX care is customizable and designed far evaluating and manitaring 7 Series FPGA GTX transceivers. This care includes b
pattern generators and checkers that are implemented in FPGA logic, and access to ports and the cdyhamic reconfiguration port attributes of the [m]
Tcl Consale — 0O & =
Z =|:reate,pr|:|jen:t managed_ip_project shonesrhansenwHDL _designsAMOT-WC7203_IBERTAVCF202_IBERT_GSG/0113/managed_ip_project -part xcwxdS5)=
sy : IMFO: [IP_Flow 19-234] Refreshing IP repositories
= INFO: [IP_Flow 19-1704] Mo user repositories specified
(17} JINFOD: [IP_Flow 19-2313] Loaded Vivado repository 'Aprodsxbuilds 2013, 2_daily_latest installs/s11n64A4 vado 2013, 2datasip'.
] i create_project: Time (s): cpu = 00:00:10 ; elapsed = 00:00:07 . Memory (MB): peak = 3543.203 ; gain = 43.945
e S INFD: [IP_Flow 12-1539] IP Catalog is up to date.
EE] P set_property Target_simulator XSim [Current_project]
x|
[
[« L ) ]

= Td Consol

e (O Messages [ Log

UGB47_c1_23_052413

Figure 1-23: IP Catalog

7. A Customize IP window opens. In the Protocol Definition tab, change

LineRate (Gbps) to 12.5, then change Refclk (MHz) to 156.25. Do not change the

other defaults (Figure 1-24).
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v Bx
IBERT 7 Series GTX (3.0) ‘ll/
ﬁ'ﬂ Documentation |2 IP Location £ Switch to Defaults

[ Show disabled ports Component Mame ||bert_?ser|es_gtx_0 |
Protocol Definition| FProtocal Selection | Clock Settings | Summary
ilicon Yersion
(® Ceneral ES/Production
O Initial ES
The maximum number of quads available for this device is 7
Mumber of Protocols
Protocol LineRate(Gbps) Datawidth RefclkMHZ) Quad Count [Quad PLL |
|custom 1 v [125 22 v | 156250 = i - Iz
R _I[3:0]
RxP_I[3:0] THM_0[3:0]
GTREFCLKO_I[D:0] THP_0[3:0]
GTREFCLKL _[[0:0] RXOUTCLK_O
SYSCLK_I
[l I+l
| ok || cance
UGB47_c1_24_060513
Figure 1-24: Customize IP - Protocol Definition
8. In the Protocol Selection tab, select Custom 1/ 12.5 Gbps in the drop-down menu
under Protocol Selected next to QUAD_113, and select MGTREFCLK1 113 in the
Refclk Selection drop-down menu (Figure 1-25).
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CTREFCLKL_I[0:0]  RXOUTCLE_O

SYSCLK |

[ [ 1~

UGB47_c1_25_060513

Figure 1-25: Customize IP - Protocol Selection

9. In the Clock Settings tab, select DIFF SSTL15 for the I/O Standard, enter E19 for P
Package Pin and E18 for N Package Pin (the FPGA pins that the system clock connects
to), and make sure the Frequency is set to 200.00 (Figure 1-26). Press OK. A Generate
Output Products window opens. Leave the defaults unchanged, and press OK.

32

www.xilinx.com VC7203 IBERT Getting Started Guide
UG847 (v3.0) July 10, 2013


http://www.xilinx.com

& XILINX.

Creating the GTX IBERT Core
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i Documenarion (05 1P Location £ Switch 10 Defaults
[ Show disabled ports Component Mame | ibert_Fseries_gtx_0 |
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Figure 1-26: Customize IP - Clock Settings

UGB47_c1_26_060513

10. Back to Manage IP, in the Sources window, right-click the IBERT IP and select Open IP
Example Design (Figure 1-27). Specify a location to save the design, press OK, and the
design opens in a new Vivado design tools window.
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Figure 1-27: Open Example Design

11. Inthe new window, select Tools > Run Tcl Script. In the Run Script window, navigate
to add_scm2.tcl in the extracted files and press OK. The SuperClock-2 Module
Design Sources and Constraints are automatically added to the example design

(Figure 1-28).
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Figure 1-28: Sources after Running add_scm2.tcl

The SuperClock-2 source code now needs to be added to the example ibert wrapper.
Double-click example_ibert_7series_gtx_0 in the Design Sources to open the verilog
code. Add the top level ports from top_scm2.v to the module declaration and
instantiate the top_scm2 module in the example ibert wrapper (Figure 1-29). Click
File > Save File.
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example_ibhert_7Fseries_gtx_0ow
o _examplefibern_Feeries_grx_0_example sros/sources_1/fimpors/fexample_designfexample_iber

%)
% ]
|
02

— O «a *

158

19 "define C_MUM_QUADS 1

20 "define C_REFCLKS_USED 1
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220
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28 dnout iZc_scl,
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41 output [1:0] sclk_clk_p,
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EENE
44

453 SF

da 4 Thert refclk internal signals

47 i

48 wire [CC_NUM_QUADS-1:0] gtrefclki_i;
49  wire [T _MUM_QUADS-1:0] gtrefclkl_i;
S0 wire [C_REFCLES_USED-1:00] refclko_1;
51 wire [C_REFCLES_USED-1:00] refclkl_i;
52 wire svsClk_d;

53

34 S

55 /S SuperClock-2 Module instantiations

& S

57  Top_scmd U_sScmd

58 {

o4 Lewsclk_ifswsclk_i7),

&0 Lusrclk_piusrclk_pd,

&l Lusrclk_nfusrclk_nd,
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71 /7 Eefclk IBUFDS instantiations

2 A

73
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ol
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Figure 1-29: SuperClock-2 in the Example IBERT Wrapper

13. In the Sources window, Design Sources should now reflect that the SuperClock-2
module is part of the example IBERT design. Right-click the IBERT core .xci filein
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Design Sources and select Set Out-of-Context (Figure 1-30). Press OK in the Set
Partition window that pops up.
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Figure 1-30: Set Partition
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14. Synthesize the partitioned IBERT core only. To do this, right-click the IBERT synthesis
run in the Design Runs window under Module Analysis Runs and select Launch
Runs (Figure 1-31). In the Launch Selected Runs window, leave the defaults
unchanged and click OK.
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Figure 1-31: Synthesize IBERT Partition

When the synthesis is done, click Run Synthesis in the Flow Navigator, which
synthesizes the rest of the design.

When that synthesis is done, a Synthesis Complete window pops up. Select Open
Synthesized Design and click OK (Figure 1-32).
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Figure 1-32: Synthesis Completed

17. When the Synthesized Design opens, select dbg_hub in the Netlist window, then
select the Debug Core Options tab in the Cell Properties window and change
C_USER_SCAN_CHAIN* to 2 (Figure 1-33). Click File > Save Constraints.
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Figure 1-33: Debug Core Options for dbg_hub

In the Flow Navigator under Program and Debug, click Generate Bitstream
(Figure 1-34). A window pops up asking if it is ok to launch implementation. Click

Yes.
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Figure 1-34: Generate Bitstream

19. When implementation completes, navigate to the project directory and locate the

resultant bitstream here:

\ibert_7series_gtx_0O\example_project\ibert_7series_gtx_0_exampl

e\ibert_7series_gtx_0_example.runs\impl_1\.
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Appendix A

Additional Resources

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see the
Xilinx Support website at:

www.xilinx.com /support

For continual updates, add the Answer Record to your myAlerts:

www.xilinx.com /support/myalerts

For a glossary of technical terms used in Xilinx documentation, see:

www.xilinx.com /company/terms

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

Further Resources

The most up to date information related to the VC7203 kit and its documentation is
available on the following websites.

The Xilinx Virtex-7 FPGA VC7203 Characterization Kit product page:

www.xilinx.com/vc7203

The Virtex-7 FPGA VC7203 Characterization Kit - Known Issues and Release Notes Master
Answer Record is AR# 52383.

These Xilinx documents provide supplemental material useful with this guide:
UGY957, VC7203 Virtex-7 FPGA GTX Transceiver Characterization Board User Guide
UG770, HW-CLK-101-SCLK2 SuperClock-2 Module User Guide

UGI08, Vivado Design Suite User Guide: Programming and Debugging

PG132, LogiCORE IP Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX
Transceivers Product Guide for Vivado Design Suite
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http://www.xilinx.com/company/terms.htm
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http://www.xilinx.com/support/myalerts
http://www.xilinx.com/products/boards-and-kits/CK-V7-VC7203-G.htm
http://www.xilinx.com/cgi-bin/docs/rdoc?v=latest+vivado;d=ug908-vivado-programming-debugging.pdf
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Appendix B

Warranty

THIS LIMITED WARRANTY applies solely to standard hardware development boards
and standard hardware programming cables manufactured by or on behalf of Xilinx
(“Development Systems”). Subject to the limitations herein, Xilinx warrants that
Development Systems, when delivered by Xilinx or its authorized distributor, for ninety
(90) days following the delivery date, will be free from defects in material and
workmanship and will substantially conform to Xilinx publicly available specifications for
such products in effect at the time of delivery. This limited warranty excludes:

(i) engineering samples or beta versions of Development Systems (which are provided
“AS IS” without warranty); (ii) design defects or errors known as “errata”;

(iii) Development Systems procured through unauthorized third parties; and

(iv) Development Systems that have been subject to misuse, mishandling, accident,
alteration, neglect, unauthorized repair or installation. Furthermore, this limited warranty
shall not apply to the use of covered products in an application or environment that is not
within Xilinx specifications or in the event of any act, error, neglect or default of Customer.
For any breach by Xilinx of this limited warranty, the exclusive remedy of Customer and
the sole liability of Xilinx shall be, at the option of Xilinx, to replace or repair the affected
products, or to refund to Customer the price of the affected products. The availability of
replacement products is subject to product discontinuation policies at Xilinx. Customer
may not return product without first obtaining a customer return material authorization
(RMA) number from Xilinx.

THE WARRANTIES SET FORTH HEREIN ARE EXCLUSIVE. XILINX DISCLAIMS ALL
OTHER WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT, AND ANY WARRANTY THAT
MAY ARISE FROM COURSE OF DEALING, COURSE OF PERFORMANCE, OR USAGE
OF TRADE. (2008.10)

Do not throw Xilinx products marked with the “crossed out wheeled bin” in the trash.
Directive 2002/96/EC on waste electrical and electronic equipment (WEEE) requires the
separate collection of WEEE. Your cooperation is essential in ensuring the proper
management of WEEE and the protection of the environment and human health from
potential effects arising from the presence of hazardous substances in WEEE. Return the
marked products to Xilinx for proper disposal. Further information and instructions for
free-of-charge return available at: www.xilinx.com\ehs\weee.htm.
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